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ABSTRACT

The purpose of this project is to build a sun tracking system for solar cell. The
efficiency of the solar cell is jmproved by adjusting the solar panel to follow the
position of the sun: The tracking system can move 270° on horizontal axis and 90° on
vertical axis. Microcontroller is applied to control the position of the panel for design
the sun tracking system which helps the solar cell to work effectively eventhough it

has sun light in a few time.
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1 0 0 0 1 0
1 0 0 1 1 0
1 0 1 0 1 0
1 0 1 1 1 0
1 1 @ 0 0 0
1 1 0 1 0 0
1 1 1 0 0 0
1 1 1 1 0 0




14

:m%mumﬁfummwumu’Lumiaaﬂuumwsmmaamww 249 mavmmuﬂunu
NITNTIVUA AU DR mmmmmﬂulﬂmummm 2.1

* ) 1
b Q‘rJ o r} = US SN7411
FT1 L‘ ET? \‘ FTI3 L_‘F'Tq,i;] Q1 SN7432
- * - o
= Us SN7411
:’ r__\L
¥ 1L

U7 SN7411

\;7 = = .
E: = B T
I = - Q2
7 o f_‘ Pt
5 | \ |
U SN7411 B
i

< o
JUN 2.12 20smunulaelding

2.5.2 2995900800 S
Qs & o 1 =l & af ﬂ:
'NmswuamaiLLazmsmuqummuwam?&mmamﬂmmgﬂw 213

\e:
T
& T4 e
i THPN
mput A 1 & & l o V.
& 1 b E < -
8o =
e o +
53 o Q =112
=N\ » T
TITHeN
input B Ry g TN, iy
AR r .. T A
ba 2 ‘J
<
R4 22 o
P“'\.A\AI:L.

o
U‘VI 213 Qﬂﬁl‘iﬂ’JUﬁMﬂ'I‘WISJU‘U?NWU&JE]LW@‘S

mmqaﬁmimuﬂumwuwawamaﬂwuulﬂmwwmamw Tuegiunisaiunu
dyaymduneitioulyituises wu tdeanslvivaimeuyulumannn yumuduuniing)
Lilloudynaduneil A Seasvilimsudawes T1 uar T4 via em‘lmwsumvmwmm
wilsuainglumanduiudrdesmsliuemesmulunedng Alidoudyayraduwnil B uile
&l udamed T2 uas T3 vhendeeadunstounssiuliueme filussiuidansetruiv
'I.un'imt;iﬂm’lwmmmwmmmmmwmwwwamaLma%‘Lm



15

2.5.3 MIAATIRTUUAILANNMSTTUNESE UL Bz Ae1995Ranea

yinnsAnlassuwuin iussuuiifissuunsasusumdsmsoniingidunuui
uanAeNuUUIug Ailddnwan Aelfidunseenvuuulidyy aiidnvusiduiineatiou
Thasidnealaenss Fan1svhauuuuionnssiawaiatuldielunsdifuamnnssnu s
mﬁu%ama%ﬁﬂ’m;ﬁu‘tﬂmnwaﬁa-'ﬁ'ﬂﬁam'zwumaa%mﬂ%'ammaa

FoRvesszuviiie nsliheesidnoatuguannsofievaiineslde warzUsulg
mwmu'mmw‘lﬂmn waziazUSulgedeseanuuuisasimivuaduiudosesessyuy
i LiJE]LU?EJ‘ULV]EJUﬂ‘inUUWﬂ"J‘UF}Mﬂ’]‘iWN’mm?ﬂhﬂﬂiﬂi)ﬂi‘ﬂ'ﬁﬁLﬂ@i%ﬁi@ﬂau‘mma‘j‘ﬁﬂ
awnsnfierlusunsuld wazduihhaulalulassnidfodiuvenasmununenoddsld
nudameslunaluaindlunsmusuueined

2.6 AYUDLADS

ala & 3 ] v - o a | A e & W o

AguawesltvRlafetunssar e Wi NS suanss namfe RTuawwesiuATDY
o =Y 1 v o ow o -1 a o @ & ' v
milalwihdniuniddunevesaweflundnuliil waefduevinmfundinuna

- P W v ¢ 5 a ¢ ¢ o

1NFUA-2.14 Wiadneussululviansdisesaenalwilvalussiuies Jeazad
LmmeanLLauaqwaTwmmmumam’lmama'wmu Finanfe wsahedulusitagad
fienadsainiunseialasiavinlugan Imﬂmiuuﬁlﬂﬁﬂuammmmmamumaua waglva
20NINUNRIANNAMVINES INngledrevesnads Fsiifiemrsaranuyilifausadniasy
LY o ¥ & 1 LY ar sJ 3 & 1 $ d
fu Wunavhlisemesnyuuasdsndenunasanun wagiiusssulnihforfunsesdiuniedis
a o I a p < £ ey [y o a a
Amneesstutiulsu i teuliieme sae wsasulWwidaunay (Back Emf) faaunns
a
.2.2

Eg = Vt vy IaRa (22)
P ) 1Y) ) alal ¢
W E, = usenulviFunduveRtLaWas (V)
o al e 4
V, - wssuneliituaduemes (V)

o 5
= AIEUANVAAINDNULIDS (A)

[y = ¢
R, E AUAUNIUTYRaIReLes (C2)



16

(n) MIvyuvesfTuames (@) Tassasuneluvesiduenes

JUN 2.14 msvivesifueweiuaslnssainimelureiduemes

Tuszvuilliffuene snléituailn Permanent Magnet DC Motor \iunawa il
1% % v A A 1 B o a & aal % v al
desldnisnseiufiaifinauiuudingn FINNITAIVANATI IV FTLemeslneldas
PoUMsaRIIeT BnsmuaumNEIveIRTeweslaumsUSusE MULsIRuANAsaYLAaIn
LI TVDRTUOW T

AU TUIRTNBIMBTLUUAU L LIMENE R SAN S s LR
E; = K, b® (2.3)
By =¥ % leR, (2.4)

Ka @@ = V. - I.R, (2.5)

W B, = wssulniiunduvesidueines (v)
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2.7 A5 19974 ATMEGA 328
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i mmwum 28 11 wariyawudeidululasneulnsaaesvuinan uiisuntouluiey
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2.7.1 puanuivaweainlulaseoulnsaass

wligaveinlilashoulnsaiass Arduino i Atmega 328 1fiu MCU aszga AVR
Uszdwein Inadenlduvasindadyyiannimuuu Crystal - Oscillator if1 16 MHz
Lﬁ@iﬁmmiﬂl‘&’muwa%mﬁamsaqnmlﬁa&hqaeﬁu

- vafaenunsaAsunisinga MCU Wusuy 28 Pin viowefduluoynsuAeaiuld
Ingliideadinsdnuadlag wiu Atmeea 88 Wuduy

- fimhpaduuy Flash 32 Koyte Taewtafiu Boot Loader 2 Kbyte

- { EPROM 1 Kbyte/s RAM 2 Kbyte
- fimesalu 14 Digital Input/Output Pins &4l 6 Pin amnsoadiady PWM

Outputs
- fimam 6 Analog Input/Output Pins
- Inszuanss (OC) 47 1/ Pin §iF1 40 mA
- Innszuanse (DC) 1 3.3V Pin fiA1 50 mA
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2.7.2 Nqefn1¥ Arduino

“Arduino” L?Jummﬁmﬁ%"’aL*E‘Ju%'amaﬂﬂﬁaﬂﬁﬁ'wuﬂuiﬂmauiwiaLaa%’msQa AVR
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- Waunsuiléianaes Arduine #131505095UN 15991 Window, Linux wag
OSx

- iULmumawmwam'ﬂm’mummmmmhﬂﬁmmsq*] numumummmwaumm

18 uavdsenansaademdasanis Library Twslq Susnldnuteds i feftmnugunganniu

2.7.3 wWiguisua@iv Arduino

dmiunisBoulusunsuey Arduio - duldniwd Co+ Fadusduuuresnimd
Uszgndguuuunily Afilaseadantsdumesianmuivsunslassuadefuaiud
wnsguily Wewslifinsuiugaitoanmuginnlumilénuanas warlvildanusald
nuisuldsunsuldie asarnnnnimadsunmduouinasgu uiluaudusiedu
Wsunsudanaalaly C-Compiler  Tmemsatflaenin Arduino  9i&nwMEN1TY9IY
WAy Text Editor 989n191 C++ fanililagagyiaiusauiu utility uisdiud Arduino
a$19umnsesiula Arduino wldguuuumavhenees Editor Wuanwiilunisinsedoans
fugldiniu dudomaeasaquin Arduino srluFenlddaulanwd uay Utility udild
L{‘Juaﬂ%aeﬁaﬁ‘ﬁumlﬂiu.ﬂimwaﬂluiﬂiﬂau‘[mataas’msga AVR Bniiuils Arduino azidenld
poulnalaasves “GNU AVR-GCC Toolchain” auiu Library Function 989 “avr-libc” @u
Utility M#luntssnlnaaldnliiu AVR a¢ldluduwes “AVRDude”
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| | ) | i fao 4 ' v v v =l |
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ol d s s ¥ ¥ o ol o l.l) 4
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| AT | ) 2. \ Al v w W
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o -1 o a o o 5
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Mululifau Fuussuiteulanuileddu Main 0 Tu ANSCIC Wules

245 amﬂmanﬁu#ugmuu RISC (Reduce Instruction Set Computer)

Ui 216 Wuantaenssadiugauu RSC e dwuilnsussnanailanimia 1
ME1/1 Clock e CPU ananaatsearamdald 1 MIPS/MHz

- yaAds 131 Adede 1 souURng

- SNamaivunn 8 Un 32 7

- prwElunisUsemananinnin 20 dwfideeiuail (MIPS) 71 20 MHz
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U1 2.16 anPnnssudugauu RISC

Taeflnmautifana g deiglud
WUBAMUT
- LY 32 Kbyte annsadouaulusunsallé 10,000 ada
- WU EPROM 1Kbyte anarsaifeusazaulusunsuld 100,000 nde
- WUU SRAM 2 Kbyte
TiRes
- 98NN 1.8 fla 25V
AR AU
- %I 0 9 4 MHz
- fimsseeiugunInisianas
- q"dﬂ'ifﬁ%‘am'sﬁa;‘gau.uuaqmmwu 12C waz USART
Bu9
- flsguu Reset wuudmlufdlotienseualnfiinlulrsreulnsaiaes
- il dunsivaounsay
- flsruunsdedomeminelusarnieuen
- fiszuunsiadumnuiianaiaes CPU
- filvunaysnunasau 5 Mode lauA Idle, ADC Noise Reduction, Power-Save,

Power-Down, Standby
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2.7.6 dauusznaudneg va919d ATmega 328

P = ' v o '
JUN 217 uananiiwiveswisne luled Atmega 328 Tnesoazidnnsentinfivous
& o Az
avvlindunelilumsed 2.2

p—

(PCINT14/RESET) PCB ] 1 28 [1PC5 (ADCS/SCL/PCINT13)
(PCINT18/RXD} PDO [] 2 27 [3PC4 {ADC4/SDAPCINT 12)
(PCINT17/TXD) PD1 [] 3 263 PC3 (ADCIPCINT 1)
(PCINT18/NTO) PD2 [ 4 251 PC2 (ADC2/PCINT 10)

(PCINT19/0C28/NT1) PD3[] 5 24 [1PC1 (ADC1/PCINTS)
{(PCINT20/XCK/TO) PD4 [ 8 23 [0 PCO (ADCO/PCINTS)
veerlz 22[3GND
GND[]8 21 ) AREF
(PCINT&/XTAL1/TOSC1) PEE [ 9 20D AvCe
{PCINTZ/XTAL2/TOSC2) PB7 [] 10 18 [0 P85 (SCKPCINTS)
(PCINT21/0COB/T1}PDS [ 11 18 {1 P24 (MISO/PCINT4)
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n.1 wnasalemsldanulnlansulames L14F1

[ ] HERMETIC SILICON
OPTOELECTRONICS PHOTODARLINGTON

L14F1/2

[ pEscripTion ]

The L14FX is a silicon photadarlington mounted in a
narrow angle, TO-18 package.

| PACKAGE D

$0 —

[0

SEATING
PLANE

[ow

e o/
SEOL M:CHEMSAX h:,::#ME,T:E R = Hermetically sealed package
T2 ko5 1% = Narrow reception angle
® | 016 [ 021 [ 407 | 533
®D | 209 | 230 | 6531 | 584
®D, | 178 | 195 | 452 | 496
e 100NOM [ 254 NOM 2
e 050 NOM_ | 1.27NOM 2
h — [0 ] = [ 7
i 036 | 046 | .92 | 116
k | 028 | 048 [ 71 [122 [ 1
L 500 | — 127 | —
a | 45° | 45° | 46° | 45° | 3

(Collector 14
connected to

case)

2B

5T1606

NOTES:

1. MEASURED FROM MAXIMUM DIAMETER OF DEVICE.

2. LEADS HAVING MAXIMUM DIAMETER .021" (.533mm)
MEASURED IN GAUGING PLANE .054" + .001" — .000
(137 + .025 — .000mm) BELOW THE REFERENCE
PLANE OF THE DEVICE SHALL BE WITHIN .007"
(.778mm) THEIR TRUE POSITION RELATIVE TO A
MAXIMUM WIDTH TAB.

3. FROM CENTERLINE TAB.
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% HERMETIC SILICON
PHOTODARLINGTON
OPTOELECTRONICS

b Sk sk sy e

Storage TOMPOratUIe . ... ...\ ou ittt et et —65°C to +150°C

Operating Temperature —65°C to +125°C
Soldering:

Lead TemperatureINOT i« v e suwms s v e B T = 240°C for 5 sec.P+5®

Lead Temperature (FIOW) oo s v 558 £55055 0 o ntm mmmmcoe ossce eros orein e ems aoscnnpis 260°C for 10 sec.?*®
Collector-Emitter Breakdown Voltage . ............ Ty, 25 Volts
Collector-Base Breakdown VOIEGE <. . .cotituiineuite e i e e e e 25 Volts
Emitter-Base Breakdown VORAGE ..o\ ... . ittt e e e 12 Volts
Power Dissipation (T, =2538) . .. ...« NNNVVM AL i e e 300 mw
Power Dissipation (T =25°C) ......... . RN AN I PP A AN W, 600 mw®

Collector-Emitter Breakdown BVgs 25 — v ;= 10mA,Ee =0

Emitter-Base Breakdown BVino 12 — v le=100V,Ee=0

Collector-Base Breakdown BVein 25 — v le=100 uA,Ee =0
Collector-Emitter Leakage leeo — 100 nA Ve=12V Ee=0

Reception Angle at '~ Sensitivity 1B, +6 Degrees

On-State Collector Gurrent L14F1 Leom 3.0 — mA Ee = .05 mW/cm?, Ve = 5V
On-State Collector Current L14F2 leons 1.0 — mA Ee =.05 mW/em®, Ve = 5 V™
Rise Time L 300 uS lc = 10 MA, Ves= 10V, R, = 10002
Fall Time t 250 usS ls= 10 mA, Vee = 10V, R, = 1000}

Derate power dissipation linearly 3.00mW/°C above 25°C ambient.

. Derate power dissipation linearly 6.00mW/°C above 25°C case.

AMA fiux is recommended.

Methanol or Isopropyl alcohols are recommended as cleaning agents.

Soldering iron tip Yis” (1.6 mm) minimum from housing.

As long as leads are not under any stress or spring tension.

. Light source is a GaAs LED emitting light at a peak wavelength of 940 nm.

. Figure 1and figure 2 use light source of tungsten lamp at 2870°K color temperature. A GaAs source of 0.05 mW/en? is
approximately equivalent to a tungsten source, at 2870°K, of 0.2 mW/cr.

DN AL




50

HERMETIC SILICON
PHOTODARLINGTON

OPTOELECTRONICS
]
6 ] ]
P il i § 4 }—] AL
(= 2.0 =
z & 1/
& = s 2 L~
£ |~ 1o £
] o > & 10
= 5 —t" | S
S H == T ¢
L-4
g re 2 -y /| -
s [y —— & /
3 0 ¥ o g'al A+—F Vgg = 5V S R —
S A N 06|~ v H=.2mwiem2 | T |
= 05 € .04
o "1 NORMALIZED T0: |/ F o
t Vee= 6V = ._
§ // Ee =.2 mW/cm? ” : N
Dda 5 10 5 20 30 a5 =50 =25 [¢] 25 50 75 100 128
Vgg - COLLECTOR TO EMITTER = VOLTS T - TEMPERATURE - °C
sTi072 A ) ST1077
Fig. 1. Light Current vs. Collector to Emitter Voltage Fig. 2. Relative Light Current vs. Ambient Temperature
Le 1o
0.9 A 100 ’ l
§ 0.8 \ 90 '
o
E 07 / 8 R | ,
2 1
o \ E 70
2 0.6 / \ E i ,
[ A = 60
508 < 3} |
2 / u 50 |
“ 0.4 [ \ % |
w \ j 40
Zo3 e o |
4 \ T 39 :
i 0.2
[ 20
0.1 10
400 500 600 70O 800 900 1000 - 10O - 1200 Peor T100) e 300 x°. K0 L3 B50* TO°  90°
A~ WAVELENGTH ~ NANOMETERS DEGREES
ST1073 ) §T1076
Fig. 3. Spectral Respcnse Curve Fig. 4. Angular Response
jad % L0aD REsisTancE ———H—F—T—F
\on g | T or
NORMALIZED TO®
\ R R, < 1000
= NCTY I = 10mA
Vee oV oY, N| Niooa
LI4F —90% ;
autPuT & A
INPUT e PULSE §
LE 36 o \\
. —10% & A\
| | ] \ 10008
LED Sl | S Lo Y
| taf—| —’-1 te o )
1{3R.  ouTpuT l__{ te bty = \
| | N Vee = 10V \
—  _Iwereesel_____ Al
= ton =ta+t  topr =ty+ 1y | I l
0.l
1] X 10 100
anors oor g RELATIVE awn?cume SPEED
ta+ te+ tg + 1
ST1075
Fig. 5. Test Circuit and Voltage Waveforms Fig. 6. Light Current vs. Relative Switching Speed

317
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n.2 1@n&sENan1slda Arduino UNO

MADE
TN ITALY

1 L]

=~ T " aL : K ; DIGITAL m:m-
' O UNO)
L B ARDUINO =+
i\ b r:}:" w-e
X me w ™
F‘.'_;H""m"""'“['??}n Avmaue

’ it L

-

|

"

Microcontroller ATmega328
Operating Voltage SV
Input Veoltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 14 (of which 6 provide' PWM output)
Analog Input Pins 6
DC Current per [/Q Pin 40 mA
DC Current for 3.3V Pin| 50 mA
32 KB of which 0.5 KB used b
PR ooy bootloader .
SRAM 2KB
EEPROM 1 KB

Clock Speed 16 MHz
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Power

The Arduino Uno can be powered via the USB connection or with an external powar supply. The power
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter
¢an be connected by plugging a 2.1mm center-positive piug into the board's power jack. Leads from a
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The boand can cperate on an external supply of € to 20 volts. If supplied with less than 7V, however, the 5V
pin may supply less than five volts and the board may be unstable. If using mere than 12V, the voltage
regulator may overheat and damage the board. The recommended range is 7 to 12 volts.

The power pins are as follows:

¢ VIN. The input voltage to the Arduine board when it's using an external power source (as opposed 10
§ volis from the USB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack. access it through this pin.

¢ 5V. The regulated power supply used to power the microcontroller and other companents on the
board. This eancome either from VIN via an on-board regulator, or be supplied by USB or another
regulated 5V supply.

¢ 3V3.A3.3volt supply generated by the on-board regulator. Maximum current draw is 50 mA.

¢ GND. Ground pins.

Memor

The Atmega328 has 32 KB of flash memory for storing code (of which 0.5 KB is used for the bootlader): It
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM librar

Input and Output

Each of the 14 digital pins an the Uno can be used as an input or output, using pinhfode(), digitalWrite(), and
digitalRead(l functions. They oparate at § volts. Each pin can provide or receive a maximum of 40 mA and
has an intemal pull-up resistor (disconnected by default) of 20-50 kOhms. in_addition, some pins have
specialized functions:

e Serial: 0 (RX) and 1 (TX). Used to recsive {RX) and transmit {TX} TTL senal data. TThese pins are
connected to the coresponding pins of the ATmega8U2 USB-to-TTL Senal chip .

+ External Interrupts: 2 and 3. These pins can be configured 1o trigger an interrupt on a low value, a
rising or falling edge. or a change in value. Sea the attachinterrupti) function for details.

¢ PWM:3, 5, 6,8, 10, and 11 Provide 8-bit PWM output with the analagWmie(} function.

¢ SPL 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPl communication, which,
although provided by the underlying hardware, is not currently incleded in the Arduino language

¢ LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is
on, when the pin is LOW, it's off.
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The Uno has 8 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By
default they measure from ground to 5 volts, though is it possible to change the upper end of their range
using the AREF pin and the analogReference() function. Additionally, some pins have specialized
functionality:

e FC: 4(SDA) and 5 {(SCL). Support °C (TWI) communication using the Wire library.
There are a couple of other pins on the board:

* AREF. Reference voltage for the analog inputs. Used with analogReference()
*» Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button o
shields which block the one on the board.

See also the mapping between Arduino pins and Atmega328 ports.

Communication

The Arduino Uno has a number of facilties for communicating with.a computer, another Arduino, or other
microcontrollers. The ATmegad28 provides UART TTL (8V) serial communication, which is available on
digital pins 0 (RX) and 1 (TX ). An ATmegaBUZ on the board channels this senal sommunication over USB
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB
COM drivers, and no external driveris.neaded. However, on Windows. an " inf file isrequired .

The Arduino software includes a serial monitor which allows simple textual data to be sent ta and from the
Arduino board. The RX and TX LEDs on the boarg will fiash when dats is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for senal communication on pins 0 and 1).

A SoftwarsSedal bbrary allows for serial communication onany of the Una’s digital pins.

The ATmegald2e aiso support 12C (TWI1) and SPI communication. The Arduino software inciudas a Wire
library to simplify use of the i2C bus see the documentation for detaiis. To use the SPIcommunication,
please see the ATmegal28 datasheet.

Programming

The Arduino Uno can'be programmed with the Arduino software (dawnload) Select ®Arduinag Uno wi
ATmegad2s" from the Tools > Board manu {according to the microcontroller on your board). For details,

see the teference and twiodals

The ATmaga328 on the Arduing Uno comes preburned with a footioader that aliows you to upload new code
to it without the use of an external hardware programmer. It communicates using the original STK500
protocol (reference, © header files).

You can also bypass the bootioader and program the micrecontroller through the ICSP {In-Circuit Seral
Programming) header; see these instructions for details.

The ATmegaBU2 firmware source code is available . The ATmegaBU2 is leaded with a DFU bootioader,
which can be activated by connecting the solder jumper on the back of the board (near the map of ltaly) and

then resetting the 8UU2. You can then use-Atmel's FLIP software (Windows) or the DFLl programmer (Mac
0% X and Linux) to load a new fimware: Or you can use the ISP header with an extemal programmer




Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a
way that allows it to be reset by software running on a connected computer. One of the hardware fiow control
ines (DTR) of the ATmegaBU2 is connected to the reset line of the ATmega328 via a 100 nanofarad
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The
Arduino software uses this capability to aliow you to upload code by simply pressing the upload button in the
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowenng of DTR
can be well-coordinated with the start of the upload

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or
so, the bootioader s running on the Uno. While it is programmed to ignore maiformed data (i.e. anything
besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. if a sketch running on the board receives one-time configuration or other data when it
first starts, make sure that the software with which it eommunicates waits 3 second after opening the
connection and before sending this data.

The Uno contains a trace that can be cut 1o disable the Quto-reset. The pads on either side of the trace can
be soidered together to re-enable-it. It's tabeled "RESET-EN". You may also be able to disable the auto-reset

by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a resetiabie polyfuse thal protecis your computer's USB ports from shoris and
overcument. Although most computers provide their own intemal protection. the fuse provides an extra layer
of protection. If morg than 500 mA is appiied to the LUSB por, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics

The maximumlength and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector
and power jack extepding beyond the former dimeasion. Three screw holes allow the board fo be attached to
a surface orcase. Note that the distance between digital pins 7 and & s 180 mil {0.18%). nat an even multiple
of the 100 mif spacing of tha othar pins.



How fo use Arduino o

Arduino can sense the environment by receiving input from a vanety of sensors and can affect its
surroundings by controliing lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language {based on Wiring) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e_g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
OS. Check on the Arduino site for the latest instructions. http./arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install
Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cabie.

Blink led

Now you're actually ready to*bum™ your B 5oi T irasno w7 o

first program on the arduino board. To | Thr: By ot cile ol TN R e e e
select “blink led”, the physical transiation o) (ay IR BB £

of the well known programming “hello
world®, select

ledlan + L>;

File>Sketchbook> N
Arduino-0017>Examples> Al
Digital>Blink INRNE S ¥ il

Once you have your skecth you'll
see something very close to the
screenshot on the right. A A

In Tools>Board select

Now youhave to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached fo.

° Tl o ¥

Press (o npile butten
ito check for e g
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Terms & Condit

ons

1.  Wamanties

41 The producer warams that 't producis Wil comiem 32 the Specfizations. THS warmanty iasis for one (1) years froem the date of e sye. The
producer shall not be ilable Tor 37y defects that are caused by negiect, mizuse or mistreatment by the Cusiormer, Inciuding improper instaiason or Bsting,
o for any produe™ st have besn ditered or mOdTed 17 3Ny WAy Dy 3 Customer, Moreover, THE [roducer sAal Not be Sadée r ary defects that resus from
Customers design. speafications or Inztructions e tuch products. Tesing and other qualty control techriques are used 1o e extent the producer deems
neceszany

12 ifany producs fi o conorm to the warmanty set forth abave, Hmmrwwmlmnmumm The procucers labiky
3l De IMITBd 1D DFOAUCT TN NE QefefMINAG by INe DFOGUCES NGt D CONMOMM T SUCh BTaNTy. If e DFDOUCEr SECE D MEpACS SUCT DIOGWCE, Te
oroducer shaii tave 3 reazonabie Sme 10 repiacements. Recaced products shai be wararded for & new 4l wamanty penad.

*3 EXCEPT AZ SET SCATH ABOVE, PROCUCTS ARE PROVIDED "AS 15" AND "WITH ALL FAULTE." THE PRODUCER DISCLAMS ALL OTHER
WARRANTIES, EXPRESS OF IMFLIED, REGARDING PRODUCTS, NCLUDNG BUT NOT LIMITED 7O, ANY IMFLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURFOSE

f4  Customer agnees hat prior 1 wahg any Systems that include the procucer products, Custome  wil fe3t such systems and he unctonaity of the
products 35 used in such systems. The producer may provide technical, Sppifcations or dezign advice, QUaity characterizalion, refatinty dats of oiher
services. Cusiomer acknowledges and agrees that crowiding tnecs senvices shai nat &pand orgtherwize ater the producer's wamantes, as et forth

apove, 3nd no ddtona obigations or labdtes shal arse from the procucer providng SUCh Senices,

1.5  The Aunc™ progucts are notauthoreed o use n Sa%et-Cricai a0ciications where 3 131Ure oF the Drocuct woud reasonably be expected 1o cause
severe pesonal infury or death. Safety-Criticy Appikcations inCiude. withat Imitason, ife support devices and syaisms, equipment or systems for Te
Dperation of ruciedr facTbes and weapons Systems. ArCuUing ™ oroducts are neither dezignad nor enced for uze it NERary Of 3ErCIOaCE ApEiCations of
envron~ents and for sulomctive appications or snvironment. Cusionier Schaowiedoes ard agrees that any such wseef ATaunc ™ products which ks soiely
athe Custoners rick, and that Tustames 2 soisy fesparzBe o complance a4 ol fagel ang regiistory nequiremants in coanection Wi such use

1.5 Customer aCKNOSECOEs anNa agress Mt it i3 soisfy responsibie for compiance Weth 8l 18gal, Y aNa Lafer;~r erenks Conteming its
products anc any uee of Arduno "™ progucts i ¢ s apel ROt Ing any arplcatonz-reiaied informaton or support that may be
provided Dy e progucer.

2. indemnification

The Custamer aCKnOWISages ad agrees to etend, ¥ and naka Te o and aganstany and all Tird-paety (0%seE, GAmMIges
Iabiidez and expenses It Incurs o the extent drectly cassed by () a0 ackul breach by 3 Cusiomer of e reprezeriation and samanties made under this
ferms and conations of 1;he grozonegiperee of Wt miscondct by the Sisiomer,

3. Consequential Damages Walver

in no event the oroducer shall te iabie 1o e Cus0Mer of any Dirg partes Br 3y SEeC. CONMErY, noect B or
exempiary J3TagE: In CaNNEction W Or aSing SR of the Droducts provided hereunder, meuvmmmum besn acvized af the
pozZbIky of such Camages. This secuon wall sarvive the Serminatcn of T warranty perind.

4. Changee to spectications

The progucer may mate Changes Io specnications 3fa procuct descripdons lm;mmmmcummunnﬂmumnmm
CharaciErsiics of anjy feakres of ivsrucions marked “resenved” or "Undefined * The PIOMUCET rezerves theze for future oefinion ana thad have no
respons i Ky whatsoever or Comiicls o iIncompathi es arising from fuure changes & them. The proclct mformattion on the Web Ste or Mxerals (2
subject 1o change Withidut notice. Do nct finailze 3 desgn i this nformation.
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n.3 1ena13ANeaN1s1491U Linear Actuator

Enatuurae:
cCAluITS.
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2

. 100% Brand New and high queity
. Heavy Duty and Long Lasting Motor

. High quality aluminum alioy material

High performance motor

. Buiit-in high' quatty imit swich

. The low noise design<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>